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Chapter 1: Overview  
 

This document is the primary reference for the A54812-SW-02 Serial Attached SCSI (SAS) switch. It describes the 

features of the switch and explains how to install and physically configure the switch. The document also explains 

how to use both the web-based interface and the command-driven interface of the SAS Domain Manager (SDM) 

utility to create storage configurations in the SAS domain. It also includes troubleshooting information.  

 

This document assumes that you are familiar with SAS devices and SAS hardware configuration. The following 

people are the intended audience of this document: 

Engineers and managers who are evaluating the A54812-SW-02 switch for possible use in a system  

System administrators and users who are installing and using the A54812-SW-02 switch 

 

1.1 A54812-SW-02 Switch Features  
The A54812-SW-02 switch has the following features:  

A total of 12 connectors that support passive copper and active cables including optical cables 

40 DataBolt  (EDFB) end-device phys architecture to achieve bandwidth aggregation  

—  FIFO-style operation  

—  Support for both SSP and STP with mode selection capability  

—  Bypass mode to provide backward compatibility 

Non-blocking feature provides simultaneous access of any port to any port at full port bandwidth 

Connectors support SAS link rates of 12.0 Gb/s, 6.0Gb/s, or 3.0Gb/s 

Connectors support Serial ATA (SATA) link rates of 6.0Gb/s, or 3.0Gb/s 

10/100 Base-T Ethernet for enclosure management 

Three hot-swap fans 

Dual hot-swap power supplies 

 

1.2 SAS and the A54812-SW-02 Switch  
SAS replaces Ultra320 SCSI as the next phase in the evolution of the SCSI standard. The SAS interface addresses 

enterprise data storage and retrieval requirements with features such as point-to-point topology, 12.0Gb/s 

transfer rate, minimum arbitration overhead, native support for both SAS and SATA drives, and smaller cables and 

connectors.  

 

In SAS storage environments, the A54812-SW-02 switch allows connection of multiple targets and initiators 

through a switched device for manageable scalability. The SDM application provides a central management point 

to view the SAS topology, manage other switches or expanders in the domain, and configure zoning to provide 

exclusive access between endpoints in the domain. The A54812-SW-02 switch allows data centers to benefit from 

the improved performance, minimum arbitration overhead, simplified cabling, and lower system implementation 

costs of SAS and SATA, while easing migration from Direct Attached Storage. 

 

The A54812-SW-02 switch is a 1U rack chassis. The following figure shows the A54812-SW-02 switch.  
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Figure 1 A54812-SW-02 Switch  

 

 

 
The A54812-SW-02 switch uses one LSISAS3x48 12 Gb/s SAS expanders, which is compliant with the ANSI Serial 

Attached SCSI specification and support SATA as defined in the Serial ATA: High Speed Serialized AT Attachment 

and the Serial ATA II: Port Selector Specification.  

 

The A54812-SW-02 switch offers advanced hardware management with an internal power supply module, three 

enclosure fans, and temperature and power supply voltage sensing and alerts. The switch is housed in a 1U 

chassis for easy shelf placement in rack-mounted server clusters.  

 

NOTE All the connectors support active cabling (optical) for longer cable runs. Passive cables can also 

be connected to these ports for normal cable runs. 
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The following figure shows how the A54812-SW-02 switch centralizes management of all application servers and 

data storage devices in the SAS domain.  

 

 

Figure 2 A54812-SW-02 Resource Management 

 

 

 

 
 

In this simplified representation, the servers at the top of the figure must access data on the storage devices in 

the lower part of the figure. The A54812-SW-02 switch manages the SAS configuration, allowing both servers to 

access all storage devices. Or, if zoning is used, single application servers can access specific storage devices 

exclusively.  

 

You can connect multiple A54812-SW-02 switches in various topologies to provide failover support and to 

increase the number of connected devices in the SAS domain. The theoretical upper limit of SAS devices in a 

domain is 16,000. The upper limit of SAS addresses in an A54812-SW-02 switch topology is 1000.  
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The following figure shows a high-level block diagram of the A54812-SW-02 switch.  

 

Figure 3 Block Diagram of the A54812-SW-02 Switch  

 

 
 

Brief descriptions of the A54812-SW-02 functional blocks follow:  

LSISAS3x48 Expander – This block includes management functions such as routing, device discovery, and 

zoning. It also includes the SDM firmware. This block controls the flow of data through the SAS connectors.  

SAS Connectors – The A54812-SW-02 switch has 12 x4 Mini SAS HD connectors, numbered 0 through 11. It 

supports connection to SAS devices at link rates of 12.0Gb/s, 6.0Gb/s, and 3.0Gb/s.  

Ethernet Phy – The external 10/100 Ethernet port provides access to the SDM management application, which 

sets up storage configurations in the SAS domain, monitors the status of the switch, and runs diagnostic tests. It 

also provides access to the SDM command line interface (CLI).  

Fans – The A54812-SW-02 switch enclosure contains three fans. The fan speed is set and can be changed and 

monitored using the SDM utility.  

Flash Memory – The LSISAS3x48 expander connects to a parallel flash memory through the expander’s 

external memory interface. This flash memory is used for firmware storage and execution, as well as nonvolatile 

data such as Ethernet MAC address and SAS World Wide Identifier (WWID).  

Temperature Sensors – The temperature sensors inputs can monitor with the SDM utility . 

 



Page 8 

1.3 DataBolt Technology 
DataBolt technology is a feature used to achieve higher bandwidth even when slower hard drives are connected. 

It is also known as end device frame buffering (EDFB) and store and forward (SnF). For example, using DataBolt 

technology, you can achieve 12Gbps bandwidth with two 6Gbps drives. The expander establishes a true 12Gbps 

link with the initiator and splits the data to two 6Gbps. Without DataBolt technology, the speed is 6Gbps, or a 

12Gbps link rate-matched to 6Gbps. 

 

 1.4 SAS Phys, Ports, and Connectors  
Phys and ports are a basic concept of SAS. A phy is the basic physical connection point for a SAS device. A phy 

contains a single transmitter and receiver, which communicate across a SAS link to a single transmitter and 

receiver in another phy, as the following figure shows.  

 

Figure 4 Link between Two Single SAS Phys  

 

 

Each single-phy link (also called a narrow port) supports a maximum bandwidth of 1200 MB/s (12.0 Gb/s) per 

direction, with a total bandwidth of 2400 MB/s full duplex in both directions.  

 

A wide SAS port consists of more than one SAS phy (an 8-phy SAS port is also possible). A wide SAS port transmits 

and receives data by using the same SAS address when connected to another SAS wide port. In other words, the 

port is created dynamically when the connection is made. The following figure shows both a narrow SAS port and 

a wide SAS port 

 



Page 9 

Figure 5 Narrow and Wide SAS Ports  

 

 
 

The A54812-SW-02 switch has 48 phys, numbered 0 through 47. Each of the 12 SAS connectors on the switch case 

(numbered 0 through 11 in this document) contains four phys, making them wide ports.  

 

During normal operation, the SAS connectors on the switch are cabled to SAS connectors on initiator devices or 

target devices. This connection creates a wide SAS port through which data is transmitted and received.  

 

1.5 SAS Connectors and Cabling  
Use a crossover cable to connect the A54812-SW-02 switch to a server or to another host device. Use 4x Mini SAS 

HD connectors (also called SFF-8644 connectors) on both ends of the crossover cable to connect the switch to the 

device. Any of the connector can support passive and active cables. 

 

The following figure shows a crossover cable with 4x Mini SAS HD connectors on both ends.  
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Figure 6 Mini SAS HD 4x Cable  

 

 
 

All cables used with the A54812-SW-02 switch must comply with the SAS 3 standard.  

 

1.6 SAS Routing and Zoning  
SAS is a connection-oriented, point-to-point technology. When a host (initiator) issues a request to read or write 

data, the A54812-SW-02 switch automatically determines how to route the connection request from the initiator 

to the correct data storage device (target). By default, any SAS initiator or target connected to the A54812-SW-02 

switch can access any other connected initiator or target in the SAS domain, without restrictions. However, 

because the SAS domain grows to include multiple hosts and multiple storage volumes, you can segregate one 

host from another host, or restrict one host from accessing storage owned by another host.  

 

SAS zoning partitions the SAS topology to isolate selected hosts from each other or to permit selected hosts to 

access only selected storage volumes. The A54812-SW-02 switch supports the full SAS 3.0 T10 zoning model.  

 

Zoning provides several benefits:  

Security – Zoning prevents users from accessing information that is not available to them.  

Manageability – Zoning reflects operational categories, such as marketing or engineering. Zoning also can 

partition hosts that run different operating systems to minimize conflicts.  

Performance – Zoning enables faster boot time because the host must discover only the storage within its 

zone or zones.  

 

1.6.1 SAS Zoning Overview 

SAS zoning access control is implemented by linked switch and expander devices, with zoning enabled. These 

devices define a Zoned Portion of a Service Delivery System (ZPSDS). No host device intervention is required. Each 

zoning switch and expander device maintains an identical zone permission table, so zone access control is 

maintained across the entire ZPSDS.  

 

To be part of the ZPSDS, the switch requires a SAS expander that supports saving the zone configuration, as 

explained in the T-10 SAS Specification. Any expander that does not support saving of the zone configuration is 

treated as a non-zoning expander and is not included in the ZPSDS. 

 

Initiators and targets see only the portions of the ZPSDS to which they are assigned in the zone permission table. 

These zoned portions are called zone groups. Zone groups are activated when they belong to a set. When the set 
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is enabled, the zoning is enforced. When the set is disabled, the zoning disappears. More than one set can exist in 

a ZPSDS, and initiators and targets can belong to more than one set. However, only one set can be active. In 

addition, more than one ZPSDS can exist in a SAS domain.  

 

A ZPSDS has a zone manager for its configuration and management. The SDM utility (see Chapter 3, SAS Domain 

Manager Graphical User Interface) configures the zone manager.  

 

The following figure shows a simple example of zoning.  

 

Figure 7 Simple Zoning Example  

 

 

 

1.6.2 Creating SAS Zones  

To create SAS zones, start by creating zone groups that include hosts or storage devices that share common 

access privileges, and zone sets that connect the zone groups together. Use the SDM utility to create zones. The 

SDM-GUI utility includes zoning wizards to create zone groups and zone sets automatically. You also can use the 

SDM utility to create zone groups and zone sets.  

 

The following rules apply to zone groups and zone sets:  

 

Only phys on the edge of the ZPSDS can be grouped into administrator-defined zone groups. Phys that 

interconnect zoning expanders are automatically placed into Zone Group 1. 

 An administrator defines zone group permissions. This procedure permits end devices attached to, or 

downstream of, the zoned phy to communicate with one another.  

A54812-SW 
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Zoning limits a host's access to only the targets downstream of zoned phys in which its zone phy is granted 

zoning access permission. A host can access all logical unit numbers (LUNs) behind the SAS phy, and it does not 

restrict access to individual storage LUNs.  

You can create up to 248 zone groups within a single zone set. 

SAS phys within a zone group cannot automatically access each other, but you can grant them access 

privileges.  

You can grant a zone group permission to access multiple zone groups, if required.  

A zone group can be a member of more than one zone set.  

A phy can be a member of only one zone group per zone set.  

A zone set must be active for its definitions to be applied to the SAS domain. Zone sets are activated in the 

SDM utility.  

Only one zone set can be active at one time. When no zone set is active, zoning is disabled and domain access 

is unrestricted.  

Changes to the active zone set (for example, a change to zone group or zone set membership, or a change to 

zone group permissions) do not take effect until the next zone set activate command.  

When the SAS topology changes (for example, when you move a host or storage attachment from one switch 

connection to another) you must manually redefine zone group permissions within the active zone set. The 

switch does not do this task automatically. Changes to the active zone set do not take effect until the zone set 

is updated and reactivated.  

Zoning is managed throughout the ZPSDS formed around the A54812-SW-02 switch, used to manage zoning, 

and any SAS 2.0 or SAS 3.0 zoning expanders that can be linked back to it without crossing a non-zoning 

expander. When zoning is enabled, zone group and permission data are migrated automatically between the 

A54812-SW-02 switches and the SAS 2.0 or SAS 3.0 zoning-enabled expanders throughout the ZPSDS. If a 

storage configuration includes a legacy expander that is not-zoning enabled, that expander and its attached 

devices inherit the zone group and permissions of the zone phy to which it is connected.  

To create a high-availability (failover) configuration, use one A54812-SW-02 switch for each data path between 

the host and the shared storage. SAS allows for only a single path between endpoints. See Figure 13 for more 

information.  

 

1.6.3 Configuring SAS Zones  

The following figure shows a sample configuration with three hosts and five JBODs.  

 

Figure 8 Configuration for Zoning Example  

 

 
Host 1 belongs to a local work group and accesses JBOD 1 as its primary resource. But Host 1 also accesses 

JBOD 2, JBOD 3, and JBOD 4 as a backup resource.  
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Host 2, a backup server, has JBOD 2, JBOD 3, and JBOD 4 as its primary resource. It also accesses JBOD 1 

Host 3, a web server, has exclusive access to JBOD 5. It also accesses JBOD 2, JBOD 3, and JBOD 4 for backup. 

Because Host 1 and Host 2 have the same JBOD access requirements, you can define them as a single zone 

group. You can define JBOD 2, JBOD 3, and JBOD 4 as a zone group because they are always used together as a 

backup resource.  

 

To create a suitable configuration, run the SDM utility and create the zone groups shown in the following figure.  

 

Figure 9 Creating Zone Groups  

 

 
 

Next, use the SDM utility to assign the following permissions, by creating zone sets:  

Zone Group 6 accesses Zone Groups 8 and 9, and vice versa.  

Zone Group 7 accesses Zone Groups 9 and 10, and vice versa.  

 

1.7 Connecting Devices to the A54812-SW-02 Switch  
The rules for connecting devices to the 12 SAS connectors on the A54812-SW-02 switch are as follows:  

Any SAS initiator can be connected to any SAS connector on the switch.  

Any SAS target can be connected to any SAS connector on the switch. A target can be a RAID array, a JBOD, 

another switch, or individual SAS drives or SATA drives.  

Switches can be cascaded by connecting any SAS connector of the downstream switch to any SAS connector on 

the upstream switch.  

When SAS zoning is used, and multiple A54812-SW-02 switches are used in the domain, the switches can be 

cabled directly to one another.  

Two switches can be connected with more than one cable to increase bandwidth between switches.  

All SAS connectors on the switch are Mini SAS HD, wide port-style connectors.  

All connections can be x1, x4 or x8. For any other configuration, contact your field applications engineer.  

The maximum connections permitted are as follows: 

— Six cascaded expanders, with each switch counting as one expander  

— Four cascaded switches  
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— A total of 64 total expanders in the topology 

 

The following examples show several ways in which you can connect devices to the A54812-SW-02 switch. 

Example 1 shows four servers (host bus adapters) and five JBODs connected to the A54812-SW-02 switch.  

 

Figure 10 Example 1, Multiple Servers and JBODs 

 

 
 

A single rack can contain the switch and all the other devices. The configuration requires nine SAS cables with a 

Mini SAS HD connector on each end. Depending on how you set up zoning for the devices, all servers could access 

data on all the JBODs, or servers could be restricted to accessing a subset of the JBODs.  

 

Example 2 shows eight servers and one RAID array connected to the A54812-SW-02 switch.  

 

Figure 11 Example 2, Multiple Servers and One RAID  

 

 

 

Each connection uses a separate cable with a Mini SAS HD connector on each end. All eight servers can access 

data on the RAID array. If more storage capacity is required, you can expand the RAID array, or you can create a 

configuration with a second cascading switch, as shown in the next example. 
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Example 3 shows eight servers and one cascading switch connected to the A54812-SW-02 switch. Several JBODs 

and RAID arrays connect to the other switch.  

 

 

NOTE  Example 5 and Example 6 also show configurations with cascading switches.  

 

Figure 12 Example 3, Multiple Servers and a Cascading Switch  

 

 
 

Example 3 shows how you can cascade two A54812-SW-02 switches to increase the number of devices in the SAS 

domain. As in Example 1, all of the servers can access all the data storage devices, or you can implement a zoning 

configuration to restrict the access. 

 

Example 4 shows a high-availability configuration in which a server is connected through two A54812-SW-02 

switches to two input connectors on a JBOD. 
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 Figure 13 Example 4, High Availability Configuration  

 

 
 

This dual porting configuration gives the server a redundant path through the switches for high availability. If one 

switch or connection fails, the server can still access the JBOD through the other connection.  

 

Example 5 shows a large data storage network that includes two A54812-SW-02 switches and several expanders.  

 

NOTE Expanders are either zoning expanders or non-zoning expanders. When SAS drives are attached to 

a zoning expander, each drive can be zoned individually and each drive can be placed in its own 

zone group. When SAS drives are attached to a non-zoning expander, they cannot be zoned 

individually. All the drives behind a non-zoning expander must be in the same zone group as the 

expander. 

 



Page 17 

Figure 14 Example 5, Large Data Storage Topology  

 

 
 

A complex zoning configuration like the one shown in Example 5 could potentially include hundreds of SAS 

initiators and targets. This flexible arrangement can easily be expanded without extensive cabling changes. The 

SDM utility detects newly added SAS devices during device discovery. You can use the SDM utility to modify and 

expand the storage configuration.  

 

NOTE  For zoning to function correctly, you must cable A54812-SW-02 switches directly to one another, 

or you must cable them through SAS 2.0 to SAS 3.0 zoning expanders.  

 

Example 6 shows a daisy chain, or cascaded, switch, configuration with four A54812-SW-02 switches. This 

example assumes that various SAS targets and SAS initiators are attached to the other connectors on the 

switches. 

 

A54812-SW 
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 Figure 15 Example 6, Cascaded Switch Configuration  

 

 
 

As in Example 3 (Figure 12), the cables in this example can run from any connector of the downstream switch to 

any connector in the switch above it. The cascade sequence is limited to four switches. 

 

Example 7 shows a star (tree) configuration of four switches, with Switch B, Switch C, and Switch D connected 

directly to Switch A. As in Example 6 (Figure 15), this example assumes that various SAS targets and SAS initiators 

are attached to the other connectors on the switches.  
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Figure 16 Example 7, Switches in a Star (Tree) Configuration  

 

 
 

NOTE  The cables can run from any connectors on Switch B, Switch C, and Switch D to any connectors on 

the central Switch A. You can attach more switches to the other connectors on Switch A. You also 

can attach additional switches to Switch B, Switch C, or Switch D 
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Chapter 2: Installation and Hardware Setup 
 

This chapter explains how to unpack the A54812-SW-02 SAS switch, install it on an optional rack shelf, connect 

power cables and other cables to it, change the default static IP address, and connect SAS storage devices to it. 

This chapter also explains how to interpret the LEDs on the switch.  

 

2.1 Unpacking the Switch  
Place the A54812-SW-02 switch shipping carton on a grounded surface before opening the carton. Open the 

shipping carton and carefully unpack its contents. The carton contains the following items:  

One A54812-SW-02 SAS switch  

Two AC power cord with inline power supply  

One USB flash drive that contains this document  

If any item is missing or damaged, contact your local reseller for replacement.  

 

2.2 Identifying Switch Components  
The following figure shows the connectors and LEDs on the A54812-SW-02 switch. Each of the 48 SAS phys has a 

corresponding fault status LED and an activity LED. The switch also includes a rate LED and activity LED for the 

Ethernet connector.  

 

Figure 17 Switch Components 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.1 A54812-SW-02 Connectors  

All 12 connectors on the A54812-SW-02 switch accept standard passive or active mini-SAS HD cabling.  See 

Chapter 1, Overview, for an explanation of SAS connectors and cables.  

2.2.2 A54812-SW-02 LEDs 

The following table shows how to interpret the LEDs for the system, the phys, and the Ethernet (RJ-45) connector. 

The LEDs in the RJ-45 connector are built into the left and right corners of the connector.  

SAS Connectors 

Activity and Fault 

LEDs (4 per x4 port) 
UART (CLI) UART (CLI) 

Ethernet 

RJ45, Two 

LEDs ->G1 (on 

top left),  & 

G2 (on top 

right) 

Dual Hot-Swap 

Power-Supplies 

Green LEDs 

indicate 

12V/5V Power 

PWR Supply Fault  

Silence Button 

Power 

Switch 
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Table 1 LED Modes  

 
LED Name Color Meaning 
Power Supply Green 12-V and 5V power is present on the board 
SAS Activity Green Blinks with activity on at least one of the four phys in the x4 SAS port. 
SAS Fault Amber - solid At least one of the phys in the x4 SAS port is down 
SAS Fault Amber - blinking All amber LEDs blinking indicates an enclosure fault. 
G2 -> Ethernet 
Link/Activity 

Green Link is active. Blinks with activity. 

G1 -> Ethernet Link 
Rate 

Green Rate of link. 
Off = 1000 Gb/s.  
On = 10/100 Mb/s. 

 

2.3 Installing the A54812-SW-02 Switch  
 

CAUTION  To prevent the A54812-SW-02 switch from overheating; do not operate it in an environment 

that exceeds the maximum recommended ambient temperature of 45 °C (113 °F).  

 

When installing the switch, consider the following information:  

The acceptable temperature and humidity operating ranges for installation and operation of the switch are as 

follows:  

— Temperature range: 15 °C to 45 °C (dry bulb)  

— Relative humidity range: 5 percent to 90 percent non-condensing  

— Maximum dew point temperature: 32 °C 

 Install the A54812-SW-02 switch in a site free from strong electromagnetic field generators (such as motors), 

vibration, and dust.  

Allow some space for proper ventilation at the front and back of the switch, where the fans draw air into the 

switch for cooling.  

The AC power adapter is rated at 100 V to 240 V, and 50 Hz to 60 Hz. 

2.3.1 Replacing a failed fan 

To replace a failed fan unscrew the two screws and pull the fan out.  Push the new fan in and secure the screws. 
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2.3.2 Replacing a failed power supply 

To replace a failed power supply slide the lever to the right and pull out the power supply.  Push the new power 

supply all the way in until the lever latches. 

 

 

 

 

 

 

 

 

 

 

2.4 Connecting to a Host  
To connect the A54812-SW-02 switch to a host, follow these steps:  

1. Attach one end of a cable to the 10/100/1000 Ethernet connector (RJ-45 connector) on the connector side of 

the switch to gain access to the SDM utility, which you use to configure and manage the switch.  

— Use a standard RJ-45 cable to connect to an external Ethernet hub or switch.  

— Use a crossover RJ-45 cable to connect directly to a computer.  

 

2. Plug the other end of the RJ-45 cable into an Ethernet hub, a switch, or a computer. Start the SDM utility on the 

host. By default, the switch supports the configuration parameters listed in the following table, which provides 

a point-to-point (non-network) Ethernet connection between the switch and the host.  

 

WARNING  Provide the A54812-SW-02 switch with an AC-protective earth-ground connection. Never 

defeat the ground conductor or operate the A54812-SW-02 switch without a suitably 

installed ground conductor.  

 

The following table lists the switch configuration defaults.  

 

Table 2 Switch Configuration Defaults Parameter Default  
Parameter Default 

Name A54812-SW-02 

POST Regular 

Active Zone Set None 

IP Address Assignment Static 

IP Address 192.168.0.100 

IP Subnet Mask 255.255.255.0 

IP Gateway 192.168.0.1 

 

You can reconfigure the switch to connect to an Ethernet network.  
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2.5 Changing the IP Address  
The default IP address initially identifies the A54812-SW-02 switch on a network. To change the IP address, use 

either the SDM-GUI application (see Chapter 3, SAS Domain Manager Graphical User Interface). 

2.5.1 Setting a Static IP Address  

Follow these steps to set a static IP address for the A54812-SW-02 switch.  

2.5.1.1 Using SDM-GUI  

1. Log on to SDM-GUI using the admin account.  

2. Select the switch from the Devices tab.  

3. Click the Operations tab.  

4. Click the Configure IP link to open the Configure IP box.  

5. Click the Static IP radio button.  

6. Configure the static IP address, DNS, and gateway provided by your network administrator.  

7. Exit SDM-GUI and power-cycle the switch.  

 

2.5.2 Setting a Dynamic IP Address  

2.5.2.1 Using SDM-GUI  

1. Log on to SDM-GUI using the admin account.  

2. Select the switch from the Devices tab. Record the switch SAS address for possible reference and identification 

later.  

3. Click the Operations tab.  

4. Click the Configure IP link to open the Configure IP box.  

5. Click the DHCP IP radio button.  

6. Power off the switch.  

7. Connect the switch to the network.  

8. Power on the switch, which now receives an IP address assignment.  

9. Run the provided Xip utility with these options to see the SAS address and IP information for all attached 

 

xip -i get avail  

For network management, contact your system administrator to create a static reservation for this IP address. 

 

2.6 Connecting SAS and SATA Hardware  
The A54812-SW-02 switch centralizes management for all SAS initiators and SAS targets in the SAS domain. The 

SAS ports on the switch are, by default, both input ports and output ports. Depending on the requirements, you 

can attach each port to a SAS host bus adapter, a SAS or SATA JBOD, a RAID array, a SAS expander or SAS /SATA 

devices. You can use any SAS port on the A54812-SW-02 switch to cascade to any port on another A54812-SW-02 

switch to increase the size of the storage configuration.  

 

Chapter 1, Overview, shows examples of various kinds of hardware configurations and explains the types of SAS 

connectors and cables that are needed for these configurations.  
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2.7 Optimizing Switch Performance with SATA Drives 
 

Due to the nature of SATA drives the performance of the SAS bus will vary depending on the SATA IOs rate.  

During domain discovery the SATA drives will stop the IO stream for 1000 milliseconds.   This interrupt of the IO 

stream will decrease the overall bandwidth.    To minimize the impact to the IO bandwidth it is recommended to 

either turn off switch discovery or change the switch discovery polling time.    Turning off the switch discovery 

does not affect the SAS domain discovery when a change occurs on the SAS domain.  The domain changes will be 

reflected back to the OS and handled correctly.   

When the switch discovery is turn off any changes to the SAS domain will not be seen by the SDM GUI.  To see the 

changes the switch discovery needs to be enabled through the SDM GUI.  Normal discovery will still occur 

updating all the servers connected to the domain.  The other option is to change the switch polling time to 

minimize the effect of the SATA delay on the bandwidth.  This document will explain how to turn off the switch 

discovery or change the switch polling time for discovery. 

The SDM GUI will be used to change the switch settings to either turn off the switch discovery of change the 

switch polling time. 

 

Option 1 Disable the switch discovery polling. 

 

Click on the “Server” menu, then “Configure”, then SDM Settings”     (see figure below). 

Figure 18 Configure SDM Settings  
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The setting window will now appear. 

Figure 19 Discovery and Polling Enabled  

 
 

Uncheck the “Discovery enabled box, then click “Apply” 

Figure 20 Polling Enabled 

 
 

Option 2 Change the polling interval 

Like option 1 select “SDM Settings”, do not uncheck “Discovery enabled” 

Change the Polling interval to 120 (2 minutes), this will reduce the effect on the SATA discovery delay. 

Click “Apply” 

 

2.8 Safety/Emissions/Susceptibility Declarations and Notices  

2.8.1 CE  

This equipment conforms to the requirements of the CE Mark and meets the following requirements: 

EN55022:2010/CISPR 22:2010 – Information technology equipment – Radio disturbance characteristics 

EN 55024:2010/CISPR 24:2010 - Information Technology Equipment – Immunity characteristics 

IEC 60950-1 Second Edition 2005-12 – Information Technology Equipment – Safety. 

 

 



Page 26 

2.8.2 North America 

FCC – This equipment has been tested to and complies with FCC Part 15B, Class A, Class B Radiated and ICES-003 

Issue 5 August 2012: Information Technology Equipment (ITE) – Limits and methods of measurement. 

 

Safety – This equipment complies with UL 60950-1/CSA 60950-1: Information Technology Equipment  – Safety – 

Part 1: General Requirements. 

2.8.3 FCC 15.19(a) (3) Notification 

 This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two conditions: 

1) This device may not cause harmful interference, and 

2) This device must accept any interference received, including interference that may cause undesired 

operation. 

2.8.4 Astek Radiated Emission Notice  

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 

accordance with the instructions, may cause harmful interference to radio communications. Operation of this 

equipment in a residential area is likely to cause harmful interference, in which case you must correct the 

interference at your own expense. Astek Corporation is not responsible for any radio or television interference 

caused by unauthorized modification of this equipment or the substitution or attachment of connecting cables 

and equipment other than those specified by Astek. It is your responsibility to correct interference caused by such 

unauthorized modification, substitution, or attachment. 

 

Chapter 3:  SAS Domain Manager Graphical User Interface  
 

This chapter explains how to use the SAS Domain Manager Graphical User Interface (SDM-GUI) application to 

configure and monitor storage configurations with the A54812-SW-02 switch. The SDM-GUI utility is a Java® 

application. To run SDM-GUI Java 7 update 65 or later must first be installed then run SDM_GUI.jar using the IP 

address of the switch. 

 

SDM-GUI has an easy-to-use graphical interface that enables you to manage the host switch and other switches or 

expanders within the domain in which the host switch resides. Use the interface to view domain information, 

create and modify aliases, and manage zone groups and zone sets. 

 

3.1 SDM-GUI Accounts  
You can run SDM-GUI from a user account or from an admin account.  

The user account allows you to view the domain topology, configuration, and operating environment. The 

default password for this account is user.  

The admin account allows you to view the same information as the user account. In addition, you can change 

the configuration of the domain and of the managed devices within the domain. The default password for this 

account is admin.  

The A54812-SW-02 switch’s zone manager password is handled separately. Its default password is blank (“”).  
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3.2 Starting SDM-GUI  
Follow these steps to start SDM-GUI:  

1. Install Java 7 Update65 or later.  

2. Run SDM_GUI.jar 

3. Enter the Switch IP address 

4. Enter your user name and password. 

5. Click Login. The main window and Summary tab appear 

 

3.3 Summary Tab and Menu Options  
The following figure shows the SDM main window, with the menu bar and Summary tab.  

 

Figure 21 SDM-GUI Main Window  

 

 

 

The Summary tab lists the Server Host Name (the IP address of the switch on which SDM-GUI is running), the 

domain status and domain ID, the overlay name, and other information. The bottom section of the window lists 

information about SDM, including the software version, the host name of the current server, and the login mode 

(admin or user).  

 

SDM only supports a single domain. 
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3.4 File, Server, and Help Menu Options  
The menu bar at the top of the SDM-GUI window provides several options for managing the server. The available 

commands are as follows:  

Select File > Refresh to scan the domain for topology or status changes. (SDM automatically scans the 

domain once per minute.)  

Select File > Exit to exit SDM.  

Select Server > Connect to return to the login screen.  

Select Server > Change Password to change passwords for either the admin account or the user account. To 

change either password, you must know the current admin password.  

Select Server > Event Log to see the event log, which you can filter by domain and by severity (optimal, 

failed, or critical).  

Select Server > Configure > SDM Settings to enable or disable discovery and polling. The following table 

describes these settings and the resulting actions: 

 

Table 3 Discovery and Polling States and Actions  

Discovery Flag Polling Interval Resulting Action 

Disable (0) Halted (0) Discovery is not initiated. Commands that trigger discovery are blocked.  

Disabled Value between 10 and 300 The client prompts you to enable discovery because it was disabled.  If 
you enable discovery, the polling interval is set to the value that you 
enter, and it takes effect immediately. 
 
If you do not enable discovery, the polling interval is set to the value 
that you enter, but it does not take effect until discovery is enabled. The 
commands that trigger discovery are blocked. 

Enabled Halted (0) Polling is disabled but discovery is triggered if you try to activate a Zone 
Set or perform any phy operation. 

Enabled Value between 11 and 300 Polling is done with a set value, and other operations run normally 

 

Select Server > Configure > Backup to create a backup of the configuration. See Section 3.8, Configuration 

Backup and Restore, for more details.  

Select Server > Configure > Smart Restore to restore a backup of the configuration. See Section 3.8, 

Configuration Backup and Restore, for more details.  

Select Server > Graphical View to view a graphical representation of the devices in the domain. As shown in 

the following figure, the Graphical View option displays a representation of the switch and the other devices 

in the domain.  
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Figure 22 Graphical View 

 
To view a list of device properties, position the mouse on top of a device icon. To view a pop-up menu of 

possible actions, right-click the mouse on a device icon.  

 

NOTE  You can also open the Graphical View window by clicking the blue words Graphical View at the 

top of the main window.  

 

Select Help > About to view information about SDM-GUI and the server on which it is running. The 

information includes the version, host name, and operating system.  

 

3.5 Views Tab  
 

The Views tab displays information about the domain, including the end device table, the alias table, zone groups, 

and zone sets. This information is available to both admin and user accounts. 

 

3.5.1 View End Device Table 

As shown in the following figure, the View End Device Table option displays a list of end devices in the domain, 

the expanders to which they attach, and their entry point into the ZPSDS, which is useful for zoning.  
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Figure 23 End Device Table 

 

3.5.2 View Alias Table 

As shown in the following figure, the View Alias Table option displays a list of all aliases.  
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Figure 24 Alias  

 

3.5.3 View Zone Groups  

As shown in the following figure, the View Zone Groups option displays a list of zone groups. To view details about 

any zone group, select it from the list on the left of the window. An asterisk following a zone group name indicates 

that the zone group is currently active.  

 

Figure 25 View Zone Groups 
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3.5.4 View Zone Sets  

As shown in the following figure, the View Zone Sets option displays a list of zone sets. To view details about any 

zone set, select it from the list on the left of the window. An asterisk at the end of a zone set name indicates that 

the zone set was active at the time of activation.  

 

Figure 26 View Zone Sets 

 

 

3.6 Domain Tab  
The Domain tab, which is available only in the admin account, has commands that manage aliases, zone groups, 

and zone sets. In addition, it has several wizards for domain configuration and management tasks. To use the 

specific commands described in this section, click the hyperlinks on the Domain tab.  

 

3.6.1 Alias Management  

The Alias Management options enable you to create, modify, and delete aliases.  

 

3.6.1.1 Create/Modify Aliases  

The Create/Modify Aliases option enables you to create or modify aliases. An alias is a user-defined name that is 

bound to a specific SAS address. After you create an alias, you can use it anywhere that you would normally use a 

SAS address. Aliases can be easily remembered names such as Summit, Turbo, or Node100.  

 



Page 33 

Figure 27 Create/Modify Aliases  

 
To assign an alias, click a node in the tree on the left of the window and type an alias of up to 24 characters in 

the Enter alias field. Click Apply to assign the alias. You can change existing aliases in addition to assigning 

new aliases.  

 

NOTE  To assign or modify multiple aliases, select each node and enter an alias for it. After you enter all 

the aliases, click Apply. 

 

 Select alias names that are unique and that do not resemble valid SAS addresses (16 hexadecimal characters that 

start with the number 5). The only special characters you can use in an alias are # (pound), - (dash), and _ 

(underscore). The tree displays aliases only for the devices presently in the domain. To see aliases for other 

devices, use the View/Delete Aliases command.  

 

3.6.1.2 View/Delete Aliases  

The View/Delete Aliases command enables you to display a list of all aliases associated with the focused domain, 

including aliases assigned to devices that are not presently in the domain. You also can also this command to 

delete aliases. 
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 Figure 28 View/Delete Aliases  

 
To delete an alias, select the check box next to it and click Delete. 

 

  

3.6.2 Automatically Configure Zone Groups and Zone Sets  

Zoning wizards simplify zone set creation. The Automatically Configure Zone Groups command and Zone Sets 

command include three wizards that automate the configuration of zone groups and zone sets.  

 

3.6.2.1 Initiator Isolation Wizard  

The Initiator Isolation Wizard creates a zone set that isolates initiators from one another, while exposing all 

targets to each other. Use the Initiator Isolation Wizard to automatically configure a zone set and two associated 

zone groups based on a snapshot of the domain. Each window of the wizard includes instructions to guide you 

through the configuration process. After it prompts you to type the zone set name (maximum of 28 characters), 

the wizard checks the domain to determine if any initiators or targets are attached to the ZPSDS at the same point 
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and share a common ZPSDS entry point. If so, the topology cannot support this zoning configuration, and the 

wizard terminates with an error message. If the topology supports the configuration, the wizard builds two zone 

groups: one group for the initiators, and one group for the targets. The groups have the names <zone set name> + 

#001 and <zone set name> + #002. The wizard scans through the domain and assigns to one zone group all the 

ZPSDS entry point phys that are upstream from initiators. The wizard assigns to another zone group all the ZPSDS 

entry point phys that are upstream from targets. The wizard then sets up permissions to allow the two zone 

groups to communicate with each other, but it prevents phys in one zone group from making connections to each 

other. When you click Apply, the wizard creates the zone set and the two associated zone groups.  

 

3.6.2.2 Connector Wizard  

The Connector Wizard automatically configures a zone set and associated zone groups by grouping connectors on 

the edge of the ZPSDS. The wizard includes instructions to guide you through the configuration process. The 

wizard uses a snapshot of the domain to identify the connectors on the edge of the ZPSDS and then displays a list 

of these connectors. (The list does not include connectors that link expanders within the ZPSDS.) Type the zone 

set name (maximum of 28 characters) and bundle the connectors into zones by selecting one or more connectors 

from the list. You can define multiple zones as needed to meet your zoning requirements. Zones can overlap, but 

the wizard removes zones that are subsets of larger zones. You can delete the defined zones by selecting the 

check box and clicking Delete.  

 

After you define all the zones, the wizard uses the zone definitions to create the minimal number of zone groups 

and to configure their permissions. The wizard creates one zone group per defined zone, populating the zone 

group with the phys associated with the connectors in that zone, and setting up permission for the phys in the 

zone group to communicate with each other.  

 

The wizard then compares each zone group to all other zone groups, including zone groups created during this 

process, searching for phys that are in both zone groups. If it finds any such phys (parents), it creates a new zone 

group (child) and moves the identified phys to the child. The wizard then grants permission for the child’s phys to 

communicate with each other, as well as with the phys of the two parent zone groups. 

 

 If one of the parent zone groups is emptied in this process, the wizard transfers all permissions from the parent 

to the child. Empty zone groups are later ignored and are not transferred to the zone manager.  

 

The wizard creates the zone set and associated zone group when you click Apply. It assigns to zone groups the 

names <zone set name> + #001, <zone set name> + #002, and so on. If the number of generated zone groups 

exceeds the maximum number of 248, the wizard displays an error message 

 

 NOTE  If phys on the edge of the ZPSDS are associated with connectors, their connectors are displayed in 

the selection list. If phys on the edge of the ZPSDS are not associated with connectors, but they 

have formed into ports (they are connected to a device), ports appear in the selection list. If phys 

on the edge of the ZPSDS are not associated with connectors and have not formed into ports, 

individual phys are displayed in the selection list.  
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3.6.2.3 End Device Wizard  

Use the End Device Wizard to automatically configure a zone set and associated zone groups by grouping end 

devices. Each window of the wizard includes instructions to guide you through the configuration process.  

 

This wizard uses a snapshot of the domain to determine the available end devices and then displays lists of 

initiators and targets. Type the zone set name (maximum of 28 characters) and bundle one or more initiators with 

one or more targets into a zone by selecting them from these lists. You can define multiple zones as needed to 

meet your zoning requirements. Zones can overlap, but zones that are subsets of larger zones are removed. The 

wizard forces devices that share the same ZPSDS entry point (siblings) into the same zone by automatically 

selecting all siblings when you select a single sibling. You can delete the defined zones by selecting the check box 

and clicking Delete.  

 

After you define all the zones, the wizard uses the zone definitions to create the minimal number of zone groups 

and to configure their permissions. The wizard creates one zone group per defined zone, populating the zone 

group with the ZPSDS entry point phys of the end devices in that zone, and setting up permission for the phys in 

the zone group to communicate with each other.  

 

The wizard then compares each zone group to all other zone groups, including zone groups created during this 

process, searching for phys that are in both zone groups. If it finds any such phys (parents), it creates a new zone 

group (child) and moves the identified phys to the child. The wizard then grants permission for the child’s phys to 

communicate with each other, as well as with the phys of the two parent zone groups.  

 

If one of the parent zone groups is emptied in this process, the wizard transfers all permissions from the parent to 

the child. Empty zone groups are later ignored and are not transferred to the zone manager. The wizard creates 

the zone set and associated zone group when you click Apply. The wizard assigns to zone groups the names <zone 

set name> + #001, <zone set name> + #002, and so on. If the number of generated zone groups exceeds the 

maximum number of 248, the wizard displays an error message.  

 

 

3.6.3 Manually Configure Zone Groups  

The Manually Configure Zone Groups commands enable you to manually create, view, modify, and delete zone 

groups. These commands provide greater control of zone set creation, and permit an administrator to edit an 

existing zone set or zone group.  

 

3.6.3.1 Create Zone Group  

The Create Zone Group command enables you to manually create zone groups. As the following figure shows, you 

create a zone group by typing a zone group name and then selecting members for the zone group from the list on 

the left of the window. 
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 Figure 29 Create Zone Group  

 
Zone group names must be unique and must be no longer than 32 characters. The only special characters you can 

use in a zone group name are # (pound), - (dash), and _ (underscore).  

 

The list of unselected zone group members contains only the expanders that are inside the ZPSDS boundary. The 

unselected members list box contains only the phys that are inside the ZPSDS boundary. 

  

3.6.3.2 View Zone Groups  

The View Zone Groups command displays information about zone groups. To view details about any zone group, 

select the group from the pull-down list on the left of the window. An asterisk at the end of a zone group name 

indicates that the zone group was active at the time of activation. Figure 25 shows the View Zone Groups window.  

 

3.6.3.3 Modify Zone Group  

Use the Modify Zone Group command to modify existing zone groups by adding or removing phys or renaming an 

existing zone group. The list of unselected zone group members contains only the expanders and phys that are 

inside the ZPSDS boundary. As the following figure shows, you rename a zone group by selecting the zone group 

from the pull-down list at the upper left of the window, typing a new name, and clicking Apply.  
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Figure 30 Modify Zone Group  

 

3.6.3.4 Delete Zone Group  

Use the Delete Zone Group command to delete an existing zone group. You can delete any zone group that is not 

currently a member of any zone set. Select the zone group name from the pull-down list in the upper left of the 

window and click Delete. 

  

3.6.4 Manually Configure Zone Sets  

Use the Manually Configure Zone Sets commands to manually create, view, activate, deactivate, and delete zone 

sets.  

 

3.6.4.1 Synchronize Zone Manager Password  

Before you can activate zoning, you must use the Synchronize Zone Manager Password command to synchronize 

the zone manager password of all the zoning expanders and switches in the domain, for example, in JBODs and 

other switches. If many expanders use different passwords, you must use this command many times, requiring 

multiple password entries for each expander.  

 

When the window appears, type the current password for any expander or switch in the indicated field. Then type 

the new password and type it again to confirm it. Repeat this process until all the zoning passwords for all 
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expanders and switches are changed to the new password. The new password can be one of the current 

passwords for any switch or expander, or it can be a new one. All expanders and switches must have the same 

password. Passwords are text strings that consist of any valid ASCII character. The maximum password length is 

32 characters. If you enter a null string, the password is set to ZERO (32 bytes of binary 0), as defined by the SAS 

2.0 specification. 

 

 If all the zoning expanders and switches inside the ZPSDS do not have same zone manager password, you receive 

a zoning password error when you activate the zoning. 

 

3.6.4.2 Create Zone Set 

Use the Create Zone Set command to create a new zone set. You can click on the matrix to indicate that both zone 

groups in the associated row/column can communicate with one another. A blank cell indicates that the two zone 

groups are not allowed to communicate. A dash in a cell indicates an illegal selection caused by a phy conflict 

between zone groups. A phy can be a member of one zone group per zone set.  

 

To see the details of a particular zone group, click the Zone Group link in the left column of the matrix.  

 

Figure 31 Create Zone Set  

 

3.6.4.3 View Zone Set  

Use the View Zone Set command to view information about zone sets. To view details about any zone set, select it 

from the list on the left of the window. An asterisk at the end of a zone set name indicates that the zone set was 

active at the time of activation. Figure 26 shows the View Zone Sets window. 
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3.6.4.4 Modify Zone Set  

Use the Modify Zone Set command to modify existing zone sets. As shown in the following figure, the Modify 

Zone Set window lets you give or revoke the permission to communicate among the zone groups. You also can 

rename an existing zone set.  

 

Figure 32 Modify Zone  

 

3.6.4.5 Activate/Deactivate Zone Set 

Use the Activate/Deactivate Zone Set command to activate or deactivate a zone set. Only one zone set can be 

active at a time, and a zone set must be active for its definitions to be applied to the domain. Changes to the 

active zone set or zone group permissions do not take effect until the next zone set activation. When all zone sets 

are inactive, zoning is disabled and domain access is unrestricted.  

 

As shown in the following figure, the Activate/Deactivate Zone Set window lists the currently active zone set. To 

deactivate all zone sets, click the button on the left of the window, and click Apply.  

 

NOTE  The default password for the zone manager is blank (“”). 
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Figure 33 Activate/Deactivate Zone Set  

 
To activate a zone set, select it from the pull-down list, type the zone manager password, and click Apply.  

 

When activated, copies of the zone set and component zone groups are made. An asterisk at the end of a zone 

group name indicates that the zone group is currently active 

 

3.6.4.6 Delete Zone Set  

Use the Delete Zone Set command to delete an existing zone set. As shown in the following figure, you delete a 

zone set by selecting the zone set from the list on the left of the window and then clicking Delete. 
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 Figure 34 Delete Zone Set 

 

 

3.7 Devices Tab  
The Devices tab displays the domain topology in the form of a tree. Select items in the tree to access a secondary 

set of tabs that can include Properties, Environmentals, Attached Devices, Phys, Operations, and SNMP. The tabs 

displayed on this row depend on both the account type and the device selected in the tree. You can access an 

Operations tab if you select an edge expander on the tree while using an admin account.  

 

The following figure shows a device tree on the Devices tab. The Properties tab appears on the right side of the 

window. 
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 Figure 35 Device Tree and Properties Tab  

 
NOTE  If there is an active zone set, and if you click on an end device, all other end devices with which it 

has permission to communicate appear in blue. 

 

To view a list of the symbols used to represent devices in the domain, click the blue word legend in the upper left 

of the window. The following figure shows the list of symbols. 
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 Figure 36 List of Symbols  

 
Note the red symbol that represents a SAS expander that does not support saving zone configurations.  

 

3.7.1 Properties Tab  

The Properties tab displays information about the device that is currently selected in the left panel. Properties 

information includes SAS Address, Vendor ID, and Device Type. The rest of the displayed information varies, 

depending on the type device that is selected. 

 

  

3.7.2 Environmentals Tab  

The Environmentals tab appears for devices that contain SCSI Enclosure Services (SES) targets. The following 

figure shows an example of the type of data that appears on this tab. Environmental data for each device that 

supports an SES target is polled in a background loop. 
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 Figure 37 Environmentals Tab 

 

 

Table 3.7.2.1 Set SES Thresholds  

In SDM-GUI you can set thresholds for temperature, fan speed and voltage elements. Two threshold types for 

each range can be set.  

High Range – High critical threshold and high warning threshold  

Low Range – Low critical threshold and low warning threshold  

When the temperature, fan speed  or voltage falls or rises to meet a set threshold value, the element enters 

either a noncritical warning state or a critical state.  

 

Temperature Threshold  

The temperature threshold range for the A54812-SW-02 switch is 1 °C to 79 °C. Threshold values outside this 

range are not accepted.  

 The warning threshold is set to 70 °C 

 The critical threshold is set to 80 °C 

 

Fans Threshold  

The fan speed threshold range for the A54812-SW-02 switch is 5,000 to 18,000 rpm. Threshold values outside this 

range are not accepted.  

 The warning threshold is set to 10,000 rpm. 

 The critical threshold is set to 5,000 rpm. 

 

Voltage Threshold  

Enter voltage values as a percentage. The voltage threshold value range for the A54812-SW-02 switch is ±5.5 

percent to ±24.5 percent of the nominal voltage. Threshold values outside this range are not accepted.  

 

SDM-GUI does not accept plus signs or minus signs. The lower end of the range is associated with the low warning 

or low critical threshold values. The higher end of the range is associated with the high warning or high critical 

threshold.  
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Set the voltage high warning threshold lower than the voltage low warning threshold. 

 

NOTE  Other device types, such as expanders, might have different temperature and voltage threshold 

range values.  

 

SDM-GUI also displays the current state of different elements. If any element is in a critical state or a noncritical 

state, SDM-GUI also displays the overall device and domain state accordingly.  

 

From the Environmental tab, click Thresholds to display or change the Threshold value, as shown in the following 

figure.  

 

Figure 38 Threshold Values  

 
 

The A54812-SW-02 switch firmware does not support changing the overall threshold. Expand the temperature 

icon or the voltage icon to get the actual elements, as shown in the following figure. The actual elements support 

the overall threshold.  

 

NOTE  The firmware for other devices might support changing the overall threshold. 
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Figure 39 Supporting Threshold Elements  

 

 

3.7.3 Attached Devices Tab  

The Attached Devices tab appears for all expanders and end devices. This tab shows a list of devices directly 

connected to the selected device and the phys used in those connections.  

 

The following figure shows the Attached Devices tab. 

 

 Figure 40 Attached Devices Tab  
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3.7.4 Phys Tab  

The Phys tab, which appears for expanders, lists information about the phys on the selected expander.  

 

The following figure shows the Phys tab. 

 

 Figure 41 Phys Tab  

 
 

To view detailed information about any phy, click on an entry in the Phy Id column. A pop-up window appears 

with detailed status information. 

 

3.7.5 Phy Counters Tab  

The Phy Counters tab, which appears for expanders, lists information about the phy error counters on the 

selected expander. 
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 The following figure shows the Phy Counters tab. 

 

 Figure 42 Phy Counters Tab 

 

3.7.6 Zone Group Tab  

The Zone Group tab becomes active if there is an active zone set and if you click on an end device. In the following 

figure, the Zone Group tab is active because the selected initiator is a member of an active zone set. In the device 

tree, the devices that can communicate with each other appear in blue. The following two sections exist in the 

Zone Group tab: 

 

 The Zone Group Membership section shows the zone group to which the selected device belongs.  

The Zone Group Permission section shows that zone_group_1 can communicate with zone_group_2.  
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Figure 43 Zone Group Tab 

 

 

3.7.7 Operations Tab  

The Operations tab appears only when you select an expander from an admin account. The following figure shows 

the commands that are listed in this tab when the A54812-SW-02 switch is selected. The commands vary 

depending on the selected device type. 

 

 Figure 44 Operations Tab 
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3.7.7.1 Download Firmware  

Use the Download Firmware command to update the firmware on Astek SAS 3.0 switches. SDM-GUI verifies that 

the product identification of the image matches the targeted device. SDM-GUI prevents downloading of 

incompatible firmware, based on the currently installed firmware version. SDM-GUI automatically resets the 

expander after a successful update.  

 

The following figure shows the first steps of the update process: First select an expander firmware image. Then 

verify and activate the file. 

 

 Figure 45 Download Firmware  

 

3.7.7.2 Upload Firmware  

Use the Upload Firmware command to upload the firmware from Astek SAS 3.0 switches. The following figure 

shows the third step of the update process: saving the file as an expander firmware image. 

 

 Figure 46 Upload Firmware 
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3.7.7.3 Enable/Disable/Reset Phys 

 Use the Enable/Disable/Reset Phys command to enable, disable, or reset specified expander phys. To disable one 

or more phys, remove the check mark in the Enabled column and click Apply. To reset one or more phys, select 

the check box in the Reset column and click Apply. The phys are automatically enabled after a switch reset. The 

following figure shows the Enable/Disable/Reset Phys window. 

 

 Figure 47 Enable/Disable/Reset Phys 

 
 

3.7.7.4 Reset Switch  

Use the Reset Switch command to reset the Astek SAS 3.0 switches that is currently selected in the device tree. 

You must confirm the reset command.  

 

3.7.7.5 Configure IP 

Use the Configure IP command to change the IP address for the Astek switches that is currently selected in the 

device tree. You can set either a static IP address or a dynamic IP address, as shown in the following figures.  
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Figure 48 Set a Static IP Address 

 
 

Figure 49 Set a Dynamic IP Address  

 

3.7.7.6 Get Date  

Use the Get Date command to obtain the switch date. SDM-GUI shows the device date in a user-friendly format.  

 

3.7.7.7 Set Date 

Use the Set Date command to set the switch date.  

 

3.7.7.8 Display Device Log  

Use the Display Device Log command to show the device log for the selected device. 
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 3.7.7.9 Performance Monitoring  

The A54812-SW-02 switch supports event counters for performance monitoring and error monitoring on all 

switch phys. An event counter can be configured to count one specific SAS event, such as transmitted SSP frames. 

Each phy can have up to four event counters configured at a time. A configuration that specifies four event 

counters is a config set. When a config set is specified, SDM sets all phys on the switch to use the same four event 

counters.  

 

The use of switch counters does not impact the switch performance. Refer to the Phy Events section of the SAS 

2.0 specification for more information about the counters used by the performance monitors and error monitors.  

 

Figure 50 Performance Monitoring Operations  

 
 

SDM-GUI supports the following three monitoring operations:  

Display – The Display Performance Monitoring Config list command shows the current configurations for all 

available config sets as shown in the following figure. The user can choose one config set out of a predefined list. 

This list is non-configurable by the user. 
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Figure 51 Display Performance Monitoring Config List 

 





Set Config – The Set active Performance Monitoring Config command, shown in the following figure, lets you 

apply a different monitoring config set. You can select the time base (in seconds) for monitoring. Changing the 

time base changes how often the switch firmware updates the monitored values. 

 

 Figure 52 Set Active Performance Monitoring Config 

 



Read – The Read performance and error monitor values command returns the current performance value and 

the error monitor value. As shown in the following figures, SDM-GUI prompts you for the starting phy and a phy 

range. Then SDM-GUI displays the current counter values of the specified phys for the active config set.  
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Figure 53 Select Range for Monitor Values  

 

 

Figure 54 Performance Monitor Values 

 
 

3.7.8 SNMP/SMTP Tab  

As shown in the following figure, the switch SNMP tab lets you configure the simple network management 

protocol (SNMP) agent or change the settings in the SNMP system management information base (MIB) 

configuration page.  
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Figure 55 SNMP Configuration  

 
 

The SNMP agent is compatible with SNMPv3. The switch also supports SNMPv1 and SNMPv2 communication. The 

switch SNMP agent supports SNMPv3 username, but it does not support authentication or privacy. For SNMPv1 

support and SNMPv2c support, the agent supports community string.  

 

NOTE  The default community string/username is public.  

 

 

Some SNMP managers use objects in the system MIB to perform a scan of the agent.  

 

The MIB is stored in a set of files that are provided to an SNMP server to describe the SNMP interface for the 

switch. The file set is included on the CD with the switch and is available for download on the Astek website. This 

specification instead defines the high-level object identifiers (OID) tree. All enterprise objects are organized under 

the node 3582.200. 

 

 

Agent Security Use the Agent Security command to configure the SNMP agent. The application provides an option 

for whether the agent uses a community string/username.  

 

The SNMP agent has the following support:  

Supports enterprise objects, organized under the node 3582.200.  

Supports the system MIB from RFC 1213. 

Supports three SNMP v2 generic TRAPs: coldStart, warmStart, and authenticationFailure. The following figure 

shows the Agent Security screen.  
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Figure 56 Agent Security 

 
 

System MIB Use the System MIB command to change the settings in the SNMP system MIB configuration page. 

Any of the three strings can be set to empty. The following figure shows the System MIB screen.  

 

Figure 57 System MIB 

 
 

SNMP TRAP IP Use the SNMP TRAP IP command to configure how the SNMP agent sends TRAPs. Up to 16 target 

IP addresses can be set. The agent sends all TRAPs to any valid IP addresses specified by this command. To disable 

an entry, clear the check box to the left of the IP address. All TRAPs are sent using the community string specified 

in the Agent Security command. The following figure shows the Trap IP screen.  
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Figure 58 Trap IP 

 
 

 

3.8 Configuration Backup and Restore  
SDM-GUI lets you store aliases, zone groups, and zone sets. There are two types of restore: restore and smart 

restore.  

To create a backup, launch the configuration backup dialog from the Server > Configure > Backup menu.  

To perform a restore, launch the configuration backup dialog from the Server > Configure > Restore menu.  

To perform a smart restore, launch the configuration backup dialog from the Server > Configure > Smart Restore 

menu. 
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 3.8.1 Restore  

Use this feature to restore zone groups, zone sets, and aliases without performing a topology match. You can 

bypass topology validation and restore configuration data on a new switch that can have a new SAS address. You 

can use this feature if the whole topology is not online and you can use it with only a switch without powering up 

other devices. This feature copies the backup configuration data onto the new switch irrespective of the present.  

 

 

Figure 59 Configuration Backup and Restore  

 

 

 

3.8.2 Smart Restore  

Use this feature to duplicate an existing setup, or to create similar zone groups and zone sets on a new setup. In 

addition, if you remove a faulty device and add a new device, this functionality can quickly restore the aliases 

from the faulty device. You can use this feature to back up any existing topology. The SDM supports the following 

conditions for successfully restoring a topology:  

You can restore the database onto another SDM host (a host on which the backup did not occur).  

The restore topology should have the same device types connected on the same phy numbers as the backup 

topology.  

The restore topology can have more devices than the backup topology.  

The restore topology cannot have fewer devices or different device types than the backup topology.  

You can change SAS addresses of any device between the restore topology and backup topology. 

Chapter 4: Troubleshooting  

 
The following table lists several troubleshooting issues related to the A54812-SW-02 switch and the remedies for 

them.  

 

Table 5 Common Troubleshooting Issues and Remedies Issue Remedy  
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Issue Remedy 

The password for the admin account is lost and 
you cannot access the switch-management 
capabilities. 

Reset the switch to factory defaults by pressing the reset switch and 
power-cycling the switch. This process resets both the admin and user 
account passwords to their default values, clears all alias and zoning data, 
and clears the event log. 

When trying to log in to the SDM-GUI utility 
from a Microsoft Windows Server® 2003 
system, the system stalls at the loading screen. 

In the Internet Explorer web browser, select Tools > Internet Options > 
Security. Click the Trusted Sites icon, then click Sites... Add the IP address 
of the A54812-SW-02 switch to the list of trusted websites. 

You changed the default IP address of the 
A54812-SW-02 switch, but you forgot the 
address and you can no longer access the 
switch through the Ethernet. 

To retrieve the IP address through an in-band connection, use the Xip utility 
supplied on the CD that ships with the A54812-SW-02 switch. To list the 
available expanders in your topology, run the following command:  
xip -i get avail 
 
This command lists all expanders in your topology with the switch IP 
address next to each switch SAS address. Alternatively, you can query 
information (including the IP address) from an individual expander by using 
its SAS address. For example, if the SAS address is 500062b15555557f, use 
this command to list information specific to that expander: 
 
 xip -i 500062b15555557f get exp  

 
All ports are showing yellow LEDs, but you still 
have SAS traffic. The switch functions at half 
performance. 

This problem might be caused by a failure of either the master controller. 
Contact your vendor to replace the switch. 
 

 

 


